
                                                                                                                          

                                                                                                                       

IBM Case Manager 5.2
Solution Deployment Guide Part 2

Advanced Solution 
Migration and Deployment 

Abstract

This guide, presented as a series of articles, focuses on the steps and tools used to 
migrate and deploy an IBM Case Manager solution from one environment to 
another. It is intended to augment the information available in the IBM Case 
Manager and FileNet P8 Information Centers. Throughout this guide, links are 
provided to Information Center topics. Review of the topics is strongly 
recommended.

The first article in this series, Part 1: Basic Solution Migration and Deployment , 
provides an overview of the entire solution migration and deployment process as 
well as procedures for migrating a solution with only IBM Case Manager assets. 
Also in the Part 1 appendix is a quick reference checklist for the entire process as 
presented by all the articles in the complete Solution Deployment Guide.

The second article, Part 2: Advanced Solution Migration and Deployment , builds 
upon Part 1 to encompass the larger solution application including other FileNet 
assets. 

The final article, Part 3: Selected External Assets Migration and Deployment, uses the 
solution application migration and deployment model outlined in the first and 
second articles but illustrates by example how two of the other IBM and external 
assets are managed.
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Overview 
Migration and Deployment Overview

Introduction 

The first article in this series, Part 1: Basic Solution Deployment and Migration, provides an 
overview of the entire solution migration and deployment process as well as procedures for 
migrating a solution with only IBM Case Manager assets. This second article, Part 2: Advanced 
Solution Deployment and Migration, builds upon Part 1 to encompass the larger solution 
application including other FileNet assets.  The reader is required to review Part 1 prior to 
reading Part 2 and should have Part 1 available for easy reference.

The following graphic illustrates the overall migration and deployment process at a high-level. 
This reflects migrating and deploying from a development environment to a non-development 
environment using a variety of tools including: IBM Case Manager administration client, 
FileNet Deployment Manager, and Process Configuration Console. The numbered bubbles 
reflect a typical order of operation. The series and order of steps can vary depending on what 
the solution application contains. For example, 

• As presented in Part 1 steps 1, 2, 6, 7, 10, and 11 are required.

• Step 10 could be before step 8 if there is external dependency in the FileNet Deployment 
Manager deploy package which requires the solution to be deployed before the deploy 
package contents can be imported . 

• Steps 4 and 8 might be needed multiple times at different points in the migration and 
deployment process depending on how the other FileNet assets are related to the 
solution and to each other. 

https://www.ibm.com/developerworks/community/groups/service/html/communityview?communityUuid=e8206aad-10e2-4c49-b00c-fee572815374#fullpageWidgetId=Wf2c4e43b120c_4ac7_80ae_2695b8e6d46d&file=3cdde542-efe9-49c8-bdc0-32de7683cad5


                                                                                                                          

Figure 1 High-level process: solution application migration DEV to UAT

IBM Case Manager Solution Deployment Guide Part 2: Advanced Solution Deployment and Migration 
expands upon how the traditional application and solution application migration models can be 
used together to support the migration and deployment of a solution application.  This article, 
covering steps 4 and 8, describes the additional tasks needed to migrate other FileNet assets that 
might be integrated into the solution application. 

Solution application migration model

As described in Part 1 of this series,  the IBM Case Manager solution migration model treats the 
development environment as the “single source” for the core solution application. Migration of 
IBM Case Manager assets always begins in the development environment.

Depending on the circumstances, some FileNet assets used in a solution might originate in the 
user acceptance test or production environments following a traditional P8 application 
migration model. Recall from Part 1 of this series, assets in the traditional FileNet application 
migration model move directly through each of the environments with the last migration being 



                                                                                                                          

from user acceptance test to production. And changes made to the application in the testing 
environments might be migrated back to the development environment.

For an IBM Case Manager solution, the assets that could migrate into the development 
environment include content engine metadata (property templates, document classes, or choice 
lists) already existing in the enterprise that is reused when designing a new solution. Another 
example is Content Platform Engine Workflow System assets defined outside of IBM Case 
Manager that are incorporated into the solution, such as a workflow system configuration or 
component queue.  

Thus the migration of a complete solution application can utilize both models. This next figure 
shows the hybrid approach as a graphical representation.

Figure 2 Advanced solution application migration

The remainder of this article presents one method using the IBM FileNet P8 tools to migrate 
other FileNet assets associated with a solution application from development and deploy them 
into a test or production environment. Discussion of the migration of  FileNet assets from a test 
or production environment back to development can be found in the topic “Deploy changes to 
an existing application” of the FileNet P8 Information Center.

http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.common.deploy.doc/scenario_update.htm
http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.common.deploy.doc/scenario_update.htm


                                                                                                                          

Ensuring object identifier stability

Key to consistency of assets as they migrate between environments is keeping a constant and 
unique identification. In the Content Platform Engine, for P8 domain or object store objects, 
unique identification is accomplished using an object identifier, or GUID (Global Unique 
IDentifier). A GUID is a 128-bit data identifier used to distinguish objects from each other. If 
there is a need to merge objects from multiple object stores into a common object store, GUIDs 
ensure objects maintain their uniqueness and  do not collide with each other in the common 
object store.

GUIDs also reduce the complexity of inter-object relationships by providing a well-managed 
reference value.  With the GUID as a reference value, objects and their dependent objects can be 
quickly and reliably located within the object store in which they reside.

For workflow system objects, such as a queue, application space, or transferred workflow, 
identification is by name.  During an import, if the object has the same name as one that already 
exists in the system, it is considered to be the same element. 

When moving objects between multiple environments, you must consider dependencies. 
Objects are often dependent on other objects in the object store, the workflow system, or on 
external resources, for example:

A workflow definition that contains references to attachments (document or folder). 
Those attachments must exist in the specified object store in the destination environment 
by the time the workflow definition is imported.

An application’s stored search definition is an XML document in an object store. The 
XML content references object stores by name and ID. This type of dependency is 
automatically handled by FileNet Deployment Manager.

A document references an external website that contains its content. This type of 
dependency has to be maintained manually. 

The extra effort of maintaining the dependencies in the destination environment can be reduced 
by following the pattern of having stable GUIDs.  Not following the stable GUID pattern might 
require additional deployment logic. 

As an example, there are two options to deploy a search template that has a dependency on a 
folder structure. 

The first option follows the practice of using stable GUIDs. FileNet Deployment 
Manager or a FileNet Content Manager addOn  is used to import the folder with the 
same GUID leading to no additional corrections deploying the search template. 

The second option creates a new folder in the destination object store letting the system 
generate a new GUID. This creates a situation where the search template must be 
manually changed to refer to the newly created folder.



                                                                                                                          

Some assets, such as the IBM Case Manager Form and Content List widgets, or IBM Forms and 
FileNet P8 eForms form templates, require the original design tools to manually fix-up a 
dependent reference. In this situation, since the design tools are not available in a non-
development environment, use of stable GUIDs across all environments is mandatory. FileNet 
Deployment Manager is used to migrate assets, and their object identifiers, between 
environments ensuring stable GUIDs.

Source and destination environment compatibility

Inherent to preparing to migrate any FileNet based application between environments is 
ensuring the source and destination object stores are compatible.  This includes: 

• Ensuring addOns which define classes or properties in the destination object store (target 
environment) are the same as in the source object store (project area or target environment). 

Note Be sure to consider addOns that modify the metadata for the default Document 
Class Definition. Any document stored in the Document Class or a subclass of the 
Document Class will be affected by that modification even if the document is not used 
by the product that installed the addOn. For example, if the IBM Case Manager target 
object store in the development environment is also configured to be an IBM Enterprise 
Records records object store, a document like an IBM Forms form template that is not 
intended to be managed as a record will still have the additional IBM Enterprise Records 
properties when it is exported. If that form template is imported into a target 
environment that does not have the addOn for a records object store applied, an import 
error can occur.

• Considering the release levels of the software and deployment tools used. Deployment 
tools such as IBM Case Manager administration client and FileNet Deployment Manager 
should be at the same release level as the server they are connecting to. The release level of 
the IBM FileNet products in the source environment should be the same as the products in 
the destination environment to avoid issues during import.

• Verifying all content to be deployed is checked in prior to starting the import process.

• Planning the corresponding administrative groups in the source and destination 
environments. The mapping between security principals in the source and destination is a 
task performed in the migrate phase described later.

• Ensuring any services required by the solution application will be available when the 
solution and associated additional assets are deployed.

For more information, see the FileNet P8 5.2 Information Center topic “About deploying to the 
Content Platform Engine server”.

Preparing the destination environment can be an iterative process if complex dependencies 
between assets are present.  The FileNet Deployment Manager change impact analysis 

http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.common.deploy.doc/deploy_ce_import_concepts.htm
http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.common.deploy.doc/deploy_ce_import_concepts.htm


                                                                                                                          

operation (also called analyze) described later in this article reports on potential import errors in 
the destination environment and the impact of the changes on the destination environment. 

The information in the change impact report should be examined to identify addOns or 
configurations missing from the destination environment, and missing required or unexpected 
items present in the converted deploy dataset. These issues must be corrected before the 
deployment can proceed. Corrective actions might include:

• Installing and configuring third-party components the solution application depends on.

• Re-exporting the assets from the source with a more focused set of include options to 
ensure the deploy dataset contains only the desired assets plus all required assets to 
support them. See the IBM Case Manager 5.2 topic “FileNet Deployment Manager include 
options for assets”.

For more information, see the FileNet P8 5.2 Information Center topic “About change impact 
analysis”.

Phase 1 
Prepare 

Identify and document additional solution application assets

During the solution design and development phase, it is important to create and maintain a 
listing of all assets in the entire solution application. As a part of this, information to assist in the 
migration and deployment process for the assets must be included.  

Note: 

For an overview of assets related to the solution package, review the IBM Case Manager 
5.2 Information Center topic “Identifying solution assets for migration”. 

For a comprehensive discussion of migration and deployment instructions preparation, 
review the IBM Case Manager 5.2 Information Center topic “Preparing customized 
migration and deployment instructions”. 

http://logos.svl.ibm.com:8094/help/topic/com.ibm.casemgmt.design.doc/acmdc068.htm
http://logos.svl.ibm.com:8094/help/topic/com.ibm.casemgmt.design.doc/acmdc068.htm
http://logos.svl.ibm.com:8094/help/topic/com.ibm.casemgmt.design.doc/acmdc043.htm
http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.common.deploy.doc/prep_data_ce_analyze_concepts.htm
http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.common.deploy.doc/prep_data_ce_analyze_concepts.htm
http://pic.dhe.ibm.com/infocenter/casemgmt/v5r2m0/topic/com.ibm.casemgmt.design.doc/acmdc046.htm
http://pic.dhe.ibm.com/infocenter/casemgmt/v5r2m0/topic/com.ibm.casemgmt.design.doc/acmdc046.htm


                                                                                                                          

For details about each type of asset migrated using FileNet Deployment Manager, see 
“FileNet P8 assets”  in the IBM FileNet P8 5.2 Information Center.

The remainder of this article assumes the reader has reviewed and is familiar with the 
concepts and terms introduced by these topics as well as Part 1 of this series.


The first article in this series, Part 1: Basic Solution Migration and Deployment, talked about the 
migration of IBM Case Manager assets. Another category of assets is called other FileNet P8 
assets. This term refers to assets stored in the Content Platform Engine and managed by FileNet 
P8 tools other than IBM Case Manager. The following table shows examples of which assets are 
other FileNet P8 assets by listing the well-known ones. 

 The following table contains information on:
Type: Short description or name of asset
Defined using: Tool used to design the asset
Resides in: Where the asset used in the solution deployment is kept in the 

development environment, for example the Design Object Store (DOS) or the 
object store for the Case Manager target environment (Target Object Store, TOS).

Migration tool: Used to export/import the asset to move between environments.
Deployment tool: Used to deploy the asset into the target environment.



Type Defined by using
Resides 
in Migration tool

Deployment 
tool

Reused Content Engine 
classes and properties

Administration 
Console for Content 
Platform Engine 

Target 
object 
store

FileNet Deployment 
Manager

FileNet 
Deployment 
Manager

Reused queues and 
component queues

Process Configuration 
Console

Target 
object 
store

Process 
Configuration 
Console and FileNet 
Deployment 
Manager

Process 
Configuration 
Console

Content Engine marking 
sets

Administration 
Console for Content 
Platform Engine 

FileNet 
P8 
domain

FileNet Deployment 
Manager

FileNet 
Deployment 
Manager

Content Engine event 
subscription

Administration 
Console for Content 
Platform Engine 

Target 
object 
store

FileNet Deployment 
Manager

FileNet 
Deployment 
Manager

Content Engine code 
module 

Administration 
Console for Content 
Platform Engine 

Target 
object 
store

FileNet Deployment 
Manager

FileNet 
Deployment 
Manager

http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.common.deploy.doc/roadmap_asset_overview.htm


                                                                                                                          

Type Defined by using
Resides 
in Migration tool

Deployment 
tool

Content Engine event 
workflow definition 

Process Designer Target 
object 
store

FileNet Deployment 
Manager

FileNet 
Deployment 
Manager

IBM FileNet eForms for P8 
form template

IBM FileNet eForms 
for P8 designer

Target 
object 
store

FileNet Deployment 
Manager

FileNet 
Deployment 
Manager

IBM Forms form template IBM Forms designer Target 
object 
store

FileNet Deployment 
Manager

FileNet 
Deployment 
Manager

Workplace XT or IBM 
Content Navigator search 
stored in the FileNet P8 
repository

Workplace XT or IBM 
Content Navigator

Target 
object 
store

FileNet Deployment 
Manager

FileNet 
Deployment 
Manager

Search templates Search Designer Target 
object 
store

FileNet Deployment 
Manager

FileNet 
Deployment 
Manager

Figure 3 Well-known other FileNet P8 assets

Information that should be collected about these other FileNet P8 assets includes:

Object dependencies - 

A dependency exists between two objects when one object references the other. 
When such objects are imported, the object that is referenced must exist in the 
object store before the object that references that object is imported. 

For dependent relationships defined by a FileNet P8 application, FileNet 
Deployment Manager understands the dependencies and ensures that the objects 
are imported in the correct sequence. 

Folder references – Path-based or GUID-based

Some operations in FileNet Deployment Manager use path-based rather than 
GUID-based references to folders. Path-based references are used to reference the 
folders parent folder, the security folder of an object, the containing folder in a 
Referential Containment Relationship (RCR), or a folder in a system or user-
defined property.  Migration of these assets must be preceded by the creation or 
import of the correct folder hierarchy.

GUID-based are often used by other components whose metadata directly 
reference a folder such as an entry template.  Migration of these assets should 
include the folder that is referenced to ensure stable GUIDs.



                                                                                                                          

addOns utilized - 

If you have objects that require an addOn on the source, that addOn must be 
installed on the destination in order for FileNet Deployment Manager to import 
the dependent objects.

Source and destination environment-specific information - 

The object store in the destination environment that corresponds to a specific 
object store in the source environment. 

The user or group in the destination environment that will be assigned the access 
privileges of a specific principal in the source environment. 

The service data in the destination environment that corresponds to specific 
service data in the source environment. 

System configuration instructions - 

System configuration steps required to complete deployment of the assets. For 
example, JAAS credentials to access the application server or database login 
information to complete a database connection specification often differs between 
environments.

The tasks in this article will focus on two asset types from the above table by using examples 
from a sample solution application:

• An IBM Forms form template stored as a document in the IBM FileNet Content Platform 
Engine. The form is used to customize the work details page. The form template is 
stored in the source target object store (either the project area in a development 
environment or the target environment in a test environment).

• A component queue managed by the workflow system component of the IBM FileNet 
Content Platform Engine. In the sample solution application,  a component queue 
named CEopsExtended processes requests from the solution application to identify what 
type of document was attached to the case by retrieving the document class name from 
the FileNet Content Manager. Migration of the component queue will include migration 
of the code module referred to by the component's Java adaptor.

The techniques shown for those two asset types can be generally applied to any asset managed 
by the Content Manager and Workflow System components of the IBM FileNet Content 
Platform Engine and migrated using FileNet Deployment Manager and Process Configuration 
Console respectively.

Perform one-time configuration and setup tasks

When an application is migrated and deployed into a system for the first time, steps beyond the 
migrate and deploy are often required to configure it in the new target environment. This is also 



                                                                                                                          

true for an application built around an IBM Case Manager solution.  These additional steps will 
be referred to collectively as system configuration. 

At application/solution redeployment, system configuration information may be overwritten 
during the redeployment process and may need re-specification. However most configuration 
steps should not need repeating. 

The types of system configuration tasks and their procedures are specific to the solution 
application and its environment. These procedures will not be discussed in this guide. However 
IBM FileNet tools used to migrate a solution application do have some setup tasks that are 
described in the following sections. Some of these tasks help to facilitate migration when the 
environments are disconnected. 

A deployment can be between connected or disconnected environments. 

Connected - one IBM Case Manager administration client or FileNet Deployment 
Manager instance is able to access the source and destination at the same time and 
performs both export and import.

Disconnected – Separate instances of the IBM Case Manager administration client or 
FileNet Deployment Manager perform the export and then the import. Example is where 
environments are separated by firewalls or the solution application is developed 
externally.

A deployment tree contains the files that FileNet Deployment Manager creates. If the 
environments are disconnected and more than one instance of FileNet Deployment Manager is 
used, then more than one deployment tree must be created. If the deployment is connected, 
only one deployment tree is needed. 

As another feature to facilitate a disconnected deployment, FileNet Deployment Manager can 
create a zip 'Deploy Package' which is easier to move between systems. This package contains 
the information about the source environment that will be needed to import the assets into the 
destination environment. If the systems are disconnected, the source environment is typically 
extracted from the deploy package  into the deployment tree for the FileNet Deployment 
Manager performing the import on the destination.  

 For additional details about the structure and content of a deployment tree, please see 
“Concepts: About FileNet Deployment Manager” in the IBM FileNet P8 Information Center.

Task – Create FileNet Deployment Manager deployment tree

If more than one FileNet Deployment Manager instance will be used to perform the export, 
import and deploy, then a deployment tree must be created for each FileNet Deployment 
Manager instance that will be used. The examples in this article implement a disconnected 
deployment between distinct FileNet P8 Content Platform Engine domains.

http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.common.deploy.doc/deploy_mgr_getting_started.htm


                                                                                                                          

The Deployment Tree data should be placed where it can be properly shared, 
managed, and backed-up. The default location is typically not the best choice. 
Depending on the situation, the FileNet Deployment Manager environments and the 
data they contain could be leveraged by multiple solution administrators for use with 
multiple environments saving time and providing a degree of consistency.

 On many versions of the Windows operating system, the Program Files and 
Program Files (x86) directories are protected, and applications cannot write to them 
unless explicitly run as administrator. The default location for the Deployment Tree is 
the FileNet Deployment Manager installation directory which is typically one of those 
two protected directories. As a consequence of not running as administrator, the 
Deployment Tree data may be physically located in Windows VirtualStore. For example, 
C:\Users\<username>\AppData\Local\VirtualStore\Program Files (x86
)\IBM\FileNet\ContentEngine\tools\deploy\P8DeploymentData.

Step Action

1 Select All Programs > IBM FileNet P8 Platform > FileNet Deployment Manager to open 
the Deployment Manager

2 On the Select Deployment Tree Location dialog, use the Browse button to select the 
desired location in the file system.

3 The main FileNet Deployment Manager dialog will appear. Click Window > Preferences

4 Review the General options. 

– Optionally deselect Enable FIPS 140-ready mode to allow FileNet Deployment 
Manager to store supplied passwords as encrypted data on disk. If option is selected, 
you will be prompted for passwords each time FileNet Deployment Manager is run. 
Additionally disabling this option allows FileNet Deployment Manager to convert 
embedded passwords for certain service data in a deploy dataset provided you also 
enter new passwords for the target service data as a part of the data mapping task. 
For details, see “About passwords” in the IBM FileNet P8 Information Center.

– Set the option Export metadata assets created by an addOn to Never.

 By choosing the option to never export metadata created with an addOn, the 
best practice is followed of introducing metadata extensions from addOns to the 
non-development environment using the same methods as used when the 
metadata was originally added to the development environment. 

For example, if a solution is integrated with a third-party product that also uses 
the FileNet Content Platform Engine, by installing the product into the non-
development environment and applying the addOn to the target object store as 
directed by the product documentation, the setup and configuration of that third-
party product will be correct. If the metadata is migrated by FileNet Deployment 

http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.common.deploy.doc/deploy_mgr_concepts_passwords.htm


                                                                                                                          

Step Action

Manager, some important configuration step might be missed causing issues when 
the solution is deployed or run.

This approach also assumes the metadata introduced by an addOn is maintained 
in both environments so they continue to be the same. Modification of the 
metadata in one environment and not the other could lead to inconsistencies on 
deployment and possible import failures.  



5 Click OK to save any changes. 

Task – Create FileNet Deployment Manager environment 

This task is used to create environments in FileNet Deployment Manager to enable the tool to 
connect to a given IBM FileNet Content Platform Engine environment. You must create an 
environment definition for each of the development and test/production environments 
involved in the solution application migration. As part of this definition, you provide the 
configuration information the tool needs to connect to the environment including the PE 
connection point referencing the project area or target environment used as the source or 
destination of the migration.

An environment can serve as the source environment in one operation and the destination 
environment in another. Thus this task does not distinguish between source and destination 
environment and only describes how to create an environment. The environment's inclusion in 
a source-destination pair later determines the role it plays at a given moment.



                                                                                                                          

 For an overview of the entire process and additional details about choices and options, 
please see “Checklist: Environment definitions” in the IBM FileNet P8 Information Center.

The basic data from an environment is gathered and stored in the deployment tree so it can be 
used in the deployment of assets. That data is stored into half maps that are created to keep the 
following information about an environment:

• Object stores
• Storage policies
• Storage areas
• Security principals
• Services (extracted from exported assets and includes a variety of information such as: 

URLs referenced from widgets used in solutions or workflow definitions, database 
connection information, user eMail addresses, WebServices referenced from IBM Forms 
or eForms forms, etc. ).

Step Action

1 Select All Programs > IBM FileNet P8 Platform > FileNet Deployment Manager to open 
the Deployment Manager. 

2 On the Select Deployment Tree Location dialog, if the desired tree is not selected by 
default, use the Browse button to locate  or create the desired tree. 

3  Click OK to open the tree.

4 Click File > New > Environment 

5 On the Create a new environment dialog, enter the environment name, claimsDEV in this 
example. 

The name of the environment should be chosen to allow for quick recognition 
of its relation to the business. Do not use a name representing its role in the 
migration process such as 'source' or 'destination' since the environment may play 
different roles at different times. A logical choice would be the same name as 
assigned to the IBM Case Manager  project area or target environment definition for 
the environment the assets are being migrated from or to.

Click Finish. 
Observe the addition of the node claimsDEV in the deployment tree. 

6 Select the claimsDEV node.

Use File > Open to open the environment.

7 Switch to CE Connection tab (at the bottom).
Enter the information needed to connect to the Content Platform Engine. 
Optionally use the Save the password option  to store the encrypted password to disk. (The 

http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.common.deploy.doc/deploy_mgr_checklist_environ_def.htm


                                                                                                                          

Step Action

option will not be available if the preference for  Enable FIPS 140-ready mode was not 
previously disabled.) 
If the option is available, enter the password now.

8 Click Test Connection to verify the connection to the Content Platform Engine and 
populate the PE Connection Point drop down. 
If the Save the password option was not chosen, enter the password now when prompted. 
If Test Connection fails, verify all Content Platform Engine connection information entered 
as the failure might be due to an incorrect hostname, port number, or user credentials.

9 Use the PE Connection Point drop down to select the connection point that corresponds to 
the project area or target environment this FileNet Deployment Manager environment will 
be used with.



                                                                                                                          

Step Action

10 Click File > Save

11 Switch back to the Overview tab (at the bottom).
Click the Retrieve Data button for the Object Store/Storage Policy/Storage Area half map.



                                                                                                                          

Step Action

12 Select the Options and Mode you wish to use. Typically the default selections are 
appropriate. For more information see “Extract an object store half map” in the IBM FileNet 
P8 Information Center.
Click OK to start the retrieval.  
Click OK on the completion dialog.

13 Nothing more will be done with the environment at this time. Later tasks will populate the 
environment with the data for the security principal and service half maps.

Phase 2 
Migrate 

Export from source environment 

Using information from the solution migration and deployment instructions, you will prepare a 
FileNet Deployment Manager deploy package and Process Configuration Console export 
configuration file.  To ensure a consistent version of the application is packaged, freeze 
development activities for the application to be migrated while the assets are being exported. 

 The 'freeze' is accomplished by coordination between the users in the development 
environment and the administrator performing the export.  Project planning and 
procedures should include how such a freeze will be communicated.

Part 1 of the Solution Deployment Guide series of articles describes the specific processes for 
using the IBM Case Manager tools to perform the basic solution migration and deployment. 
This second developerWorks article describes the specific processes for using the FileNet tools 
for exporting and importing other FileNet P8 assets. For all the articles in this series, any task 
described as occurring during the export portion of the migrate phase is performed during the 
same time period.

http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.common.deploy.doc/deploy_mgr_howto_object_store_half_maps.htm


                                                                                                                          

As a best practice, the exported assets originally used to migrate the solution application for 
testing are used again to migrate the solution application to the production environment. This 
ensures the integrity of the application that is migrated to the production environment.

The remaining sections of this article describe the specific processes to export and import other 
FileNet P8 assets using FileNet Deployment Manager and the Process Configuration Console, 
and perform required post-deployment configuration changes to support the imported P8 
assets used for the example in this guide.  

Task 4a – Export FileNet workflow system configuration 

Export the required Content Platform Engine Workflow System assets from the target object 
store in the project area of the development environment where the solution application was 
created and tested. Required Workflow System assets are those created with the Process 
Configuration Console or Process Designer and not directly in Case Manager Builder. These 
assets are not managed by IBM Case Manager, but the solution might directly incorporate them. 
Or the business processes that are part of your solution application might use these assets. 
Examples of these assets include: component queues or workflow system configuration 
parameters.

Use the Process Configuration Console from within IBM Administration console for Content 
Platform Engine to export Workflow System assets from the development environment target 
object store to the test/production environment target object store. 

Complete the export with the following in mind:

)a Only select assets created with tools other than Case Manager Builder. Direct migration 
of assets such as work queues or event logs that will be created by the solution deploy 
operation can cause conflicts. Assets managed by IBM Case Manager can often be 
recognized by the presence of the solution prefix in their name or by their name being 
the same as the solution name.

)b Use the Include System Properties option to export workflow system configuration 
information. Note that some configuration information is environment specific and 
may need to be edited using Process Configuration Console on the destination system 
once the solution application is deployed.

)c If you are exporting only System Properties, select Export selected components under 
Export Type and deselect all components.

Include the resulting XML file as a part of the files in the solution application package when 
preparing to migrate a solution.



                                                                                                                          

Step Action

1 Log into the IBM Administration Console for Content Platform Engine (ACCE) using the 
URL

http://<CPEserver_host:CPEserver_port>/acce 

For example, the default URL when using IBM WebSphere as the application server is: 
http://localhost:9080/acce

For example, the default URL when using Oracle WebLogic as the application server is: 
http://localhost:7001/acce

2 Open the object store used as the target object store for the project area the solution 
application will be migrated from.

3 The Process Configuration Console can be found for a given object store on the 
Administrative node, Workflow System > Actions > Configure Workflow Settings

4 After the  Process Configuration Console java applet is launched, from the Workflow 
Systems listed, select the connection point for the project area where the solution 
application resides.  With the Action menu, use the Connect operation and connect to the 
desired workflow system isolated region.



                                                                                                                          

Step Action

5 With the Action menu, use the Export to XML file operation to launch the export wizard.

6 On the Export Configuration dialog, use the Browse button to select a location and fill in a 
name for the Export File.



                                                                                                                          

Step Action

 Recommendation is to use a file name that describes the version of the assets 
being exported using the current date, a version designation, or some other 
labeling that can later identify this export file when it is copied to another system 
for import.

Click Save .



                                                                                                                          

Step Action

7 Select an Export Type of Export selected components.

In the example used for this article, only a component queue definition needs 
to be exported. You will choose different options if you need to export other 
FileNet P8 workflow system assets.

Click Next 



                                                                                                                          

Step Action

8 Deselect the check box at the topmost node to cause all subordinate check boxes to be 
deselected.

Open the node for the desired export component. In our example that is Component 
Queues .

Check the box corresponding to the desired export component. In our example this is the 
component queue named CEOpsExtended.

Click Next .

9 On the Summary dialog, review the information to verify it is correct.

Click Finish to begin the export operation.

When the Summary dialog closes, the export operation is complete.

10 Close the Process Configuration Console by using File > Exit .

Task 4b – Export FileNet Content Manager assets 

Export the required FileNet Content Manager assets from the target object store in the project 
area of the development environment where the solution application was created and unit 
tested. The export operation offers a choice of include options. These options direct FileNet 
Deployment Manager to include some, all, or none of the associated objects that an asset is 
dependent on as a part of the deploy dataset. Thus the deploy dataset can be directed to contain 
dependent objects without a requirement to explicitly identify and add each associated object to 
the export manifest. 



                                                                                                                          

Utilize export include options to narrowly focus the export. This approach is intended to avoid 
implicit inclusion of unwanted objects that can be caused by the propagation behavior of the 
include options. For a more detailed explanation, see the IBM Case Manager 5.2 topic “FileNet 
Deployment Manager include options for assets”.

Step Action

1 If needed, open the FileNet Deployment Manager and desired deployment tree. 

2 In the Environments node, navigate to and expand the node for the environment that will 
be used as the source for the export. 

3 On the Export Manifests node for the source environment, right-click and select New > 
Export manifest

4 On the Create a new export manifest dialog, enter a name. In this example, 
ClaimsSolutionFileNetAssets is used.

 This name is used by later operations in FileNet Deployment Manager as a 
suggested default name. Assign a name that describes what the contents of the 
deploy dataset generated from the export manifest will be. Then those later default 
names will be useful and understandable.

Click Finish to create the empty export manifest XML file under the source environment in 
the deployment tree.

http://pic.dhe.ibm.com/infocenter/casemgmt/v5r2m0/topic/com.ibm.casemgmt.design.doc/acmdc046.htm
http://pic.dhe.ibm.com/infocenter/casemgmt/v5r2m0/topic/com.ibm.casemgmt.design.doc/acmdc046.htm


                                                                                                                          

Step Action

5 In FileNet Deployment Manager. double-click on the new export manifest node 
ClaimsSolutionFileNetAssets.xml to open the manifest and launch the export manifest 
editor.

6 Click on the green plus symbol on the tool bar to add assets to the manifest from the 
FileNet P8 domain.

7 Using the navigation pane on the left, open the object store used as the target object store 
for the project area on the IBM Case Manager development system where the solution 
application was developed. Select nodes under the object store node to browse for assets to 
be added to the manifest.

Using the right-hand pane, select and Add all of the FileNet P8 assets that should be 
exported. In this example, the next few steps will show adding these assets to the manifest:

• The IBM Forms form template (FNOL_IBM_FORM_AC.xfdd) document and its parent 
folder, named forms, will be exported. However because the folder forms contains more 
than just the one desired form template, it and the form template document will be 
added to the export manifest as distinct entries with focused include options 
appropriate for the type of object.

• The code module CEOpsExtended used by the component queue's Java adapter and its 
parent folder named CodeModules_WF will also be exported. Since that folder was 
created especially to contain the code module, the include options in this example can 
be less focused and used to also implicitly export the parent folder with the code 
module document as a dependent object.



                                                                                                                          

Step Action

8 First the parent folder forms is added by navigating to its parent folder (Root Folder) in the 
navigation (left) pane and selecting then adding forms in the add assets (right) pane. An 
asset can be added to the export manifest by either:

◦ single-clicking the asset in the right-hand pane to select and then using the Add 
button. 

◦ double-clicking the asset in the right-hand pane.

◦ right-clicking on the asset and selecting Add from the context menu.

After it is added, each asset is listed in the export manifest with identifying information 
such as display name and GUID.

9 The add assets process is repeated to add the desired form template document to the export 
manifest. Using the left-hand navigation pane, open the parent folder forms. 

The document named  FNOL_IBM_FORM_AC.xfdd is added to the export manifest by 
double-clicking it in the right-hand add assets pane.

Notice how both the folder object named forms and the document object named 
FNOL_IBM_FORM_AC.xfdd are now present in the export manifest.



                                                                                                                          

Step Action

10 Lastly the document representing the code module is added to the export manifest.

11 Click the Close button to close the Add Assets dialog.



                                                                                                                          

Step Action

12 In the export manifest list, the Include Options column contains the word 'default' 
indicating the default include options are currently assigned. This will be modified.

 Hover over the cell in the Include Options column to view current settings. 

All the assets are selected to allow the include options they have in common to be 
modified.

Click the pencil icon on the tool bar to invoke the Include Options dialog.

13 On the Include Options dialog, the None button is used to clear all the include options 
directing the export process to only export the asset listed in the export manifest.

Click OK to accept the Include Options.

14 Click File > Save to save the export manifest created at this point.

15 Observe in the export manifest list, the Include Options column contains the word 'none' 
indicating no include options are currently assigned for any of the assets in the export 
manifest.

Next only the document named  FNOL_IBM_FORM_AC.xfdd is selected on the export 
manifest list and the pencil icon is pushed on the tool bar to invoke the Include Options 
dialog.

To ensure the document will be filed into the forms folder when it is imported, the include 
option Include relationships to containing folders is selected.

Click OK to accept the Include Options.



                                                                                                                          

Step Action

16 Next only the document named  CEOpsExtended is selected on the export manifest list and 
the pencil icon is pushed on the tool bar to invoke the Include Options dialog.

To ensure the document, its containing folder and their relationship, will be exported into 
the deploy dataset, the include options Include parent folders, Include relationships to 
containing folders are selected.

Click OK to accept the Include Options.



                                                                                                                          

Step Action

17 Click File > Save to save the export manifest created at this point.

18 Close the tab for export manifest ClaimsSolutionFileNetAssets.xml

19 In the navigation pane, right-click on the  ClaimsSolutionFileNetAssets.xml node and 
select Export to start the export wizard.

20 On the Export Options dialog, note how the descriptive name chosen for the export 
manifest is used, by default, for the deploy dataset name. The name of the deploy dataset 
(ClaimsSolutionFileNetAssets) can be changed if a different one is desired.

Accept the defaults and click OK to start the export process.



                                                                                                                          

Step Action

21 Wait for the dialog indicating a successful completion. 

22 On the completion dialog, verify the number of items processed matches the expected 
number of assets. In this example, six items were processed: 

• The folder forms , the document FNOL_IBM_FORM_AC.xfdd, and the relationship 
between them = 3 items.

• The code module document CEOpsExtended along with its parent folder and their 
relationship = 3 items.

If the number of items greatly outnumber the assets in the export manifest, or many more 
items than expected were processed, examine the deployment.log file for the export process 
to look for unexpected items.  Refer to the IBM Case Manager 5.2 topic “FileNet 
Deployment Manager include options for assets” for tips on how to  use the include 
options to focus the export of assets.

The deployment.log file is located in the Temp directory of the deployment tree using a 
date/time naming scheme. In the example, the deployment log is located at 
C:\Demo\FileNet Deployment 
Managerdata\Temp\Run.2013.09.17.18.24.06\deployment.log 

http://pic.dhe.ibm.com/infocenter/casemgmt/v5r2m0/topic/com.ibm.casemgmt.design.doc/acmdc046.htm
http://pic.dhe.ibm.com/infocenter/casemgmt/v5r2m0/topic/com.ibm.casemgmt.design.doc/acmdc046.htm


                                                                                                                          

Step Action

  When building the deploy dataset, ensure an asset's dependencies are considered. For 
example:

• If a deployed code module is revised, then any action referencing the code module does 
not reference the latest version. To avoid this situation, it is important to include the 
referencing actions in the export. Alternatively, you can manually update the 
referencing actions on the destination system by copying a reference of the code module 
into the action object.  In addition to action objects  like an event action or change 
preprocessor, referencing elements can include a Java component adapter configured for 
a component queue. The component queue configuration is exported using the Process 
Configuration Console. See “Task - Export FileNet P8 Workflow System configuration” 
above. 

• If a new version of a workflow definition document is exported, the workflow 
subscription that references it should be exported as well.  This allows the FileNet 
Deployment Manager import option Transfer workflows after import to be used at 
import time to automatically update the workflow subscription to reference the newly 
imported and transferred workflow.

• If a pre-existing export manifest will be used, ensure that any document objects listed 
reference the correct version of the document. The export manifest refers to a specific 
document version and may need to be updated (the document removed and re-added to 
the manifest) if the document version has changed.


For more information about deploying code modules, see “Deploying Java action handlers” in 
the FileNet P8 5.2 Information Center.

http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.ce.dev.ce.doc/server_procedures.htm?resultof=%22action%20object%22%20


                                                                                                                          

Task 4c – Create security principals half map 

For a source half map, it is best to retrieve principal data from a  deploy dataset such as the one 
created in the previous task “Export FileNet Content Manager assets”. This creates a relatively 
small source security principals half map containing the principals that need to be converted for 
the import of assets the deploy dataset contains. Retrieving this focused list of security 
principals takes much less time than retrieving all the principals from a large LDAP directory.

To ensure the half map contains all the expected security principal field values and avoid 
potential issues when the security principal half map is used on the destination system, it is best 
practice to fetch the complete values from the LDAP. To avoid a fetch of all entries from a 
potentially large LDAP repository, the following procedure will show using the LDAP filter 
option Use Environment's Principal Half Map to augment the information obtained from the 
smaller deploy dataset with information from the actual LDAP.

For details on the process and options to create a security principal half map, see the FileNet P8 
5.2 Information Center topic “Extract a security principal half map”.

Step Action

1 If needed, open the FileNet Deployment Manager and desired deployment tree. 

2 In the Environments node, navigate to and expand the node for the source environment. 

3 Double-click on the source environment node (claimsDEV in the example) to open it.

4 Use the Retrieve Data button for the type Security Principal to start the wizard to retrieve 
the data.

http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.common.deploy.doc/deploy_mgr_howto_security_principal_half_map.htm


                                                                                                                          

Step Action

5 On the first Retrieve Data for Security Principal Half Map dialog, choose Deploy Dataset 
File .

6 On the next Retrieve Data for Security Principal Half Map dialog, 

• Use the Browse button to select the deploy dataset  containing the exported assets the 
principals will be extracted from. In our example the deploy dataset is located in the 
deployment tree at C:\Demo\FileNet Deployment 
Managerdata\Environments\claimsDEV\Assets\ClaimsSolutionFileNetAssets

• For the mode, 

◦ if you are using an existing FileNet Deployment Manager environment and want 
to add security principals, choose Merge.

◦ if you wish to utilize only the principals in this particular deploy dataset, choose 
Overwrite. 

◦ For a new environment, the choice or Merge or Overwrite yields the same result.

 For this example, Overwrite was chosen.

Click Finish to start the extraction process.

7 Verify the process completed successfully.

Click OK to dismiss the   Build principal half map dialog.

8
 When security principal data is retrieved only from a deploy dataset or configuration 

export file, the resulting security principal half map could be incomplete and might not 
contain expected values for the SID or shortname if the exported asset did not have all those 
values stored with it. 

Since this example will create a deploy package to use in a simulation of a solution 
migration across disconnected environments where information from the source 
environment LDAP is not available at the destination, this best practice  of fetching the 
complete LDAP information at the source will be followed. 


Start by repeating step 6 and use the Retrieve Data button for the type Security Principal to 
start the wizard to retrieve the data.

9 On the first Retrieve Data for Security Principal Half Map dialog, choose From Content 
Engine's LDAP Provider .

10 On the next Retrieve Data for Security Principal Half Map dialog, 

◦ Use the Retrieve Realms button to cause FileNet Deployment Manager to 
populate the available LDAP Realms.

◦ Choose the appropriate LDAP realm (the example only has one possibility)

◦ For the Filter, choose Use Environment's Principal Half Map .



                                                                                                                          

Step Action

◦ In the Filter Settings , select the source environment where the desired security 
principal half map resides, in this example claimsDEV .

◦ For the Mode choose Merge to allow labels that might have been added to the half 
map to be retained.

Click Finish to start the extraction process. 

11 Verify the process completed successfully.

Click OK to dismiss the   Build principal half map dialog.

12 In the navigation pane, double-click on the Security Principal Data node of the source 
environment to open the Security Principal half map.

13 Optionally assign values in each row for the Label column. Labels in the half maps for the 
source and destination environments are matched automatically when the source-
destination pair data maps are built. 

Using labels is a good way to let the software automatically map security 



                                                                                                                          

Step Action

principals created in the Prepare phase of deployment.

14 If labels are added or modified, use File > Save to commit them in the half map.

15 Close the Security Principal half map tab.

 

Task 4d – Create services half map 

This task is optional depending on the solution application design. In our example, the IBM 
Forms form template contains a web services reference that will need to be mapped to a valid 
value for the destination environment.

Service information can be extracted from the following sources:

• FileNet Content Manager deploy dataset containing documents whose content can be 
processed by FileNet Deployment Manager to extract the service data. In the IBM Case 
Manager system, many document types are supported by FileNet Deployment Manager 
including:  Case Manager pages, workflow definitions and form templates.

• FileNet workflow system configuration export file: Service information might be present 
for  region-wide properties, such as specified web applications. Content Platform Engine 
user information can also appear in the service half map extracted from a configuration 
export file. 

•  Service half map for the source FileNet Deployment Manager environment: The service 
half map data gathered from the source environment provides a starting point for 
creating a service half map to use for the destination environment. This technique will 
be used later in this article.

• Note that if you attempt to extract service data from a set of assets, but none of their 
content contains service information, no error occurs and the service half map remains 
empty. 

For details on the process and options to create a service half map, see the FileNet P8 5.2 
Information Center topic “Extract a service half map”.

http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.common.deploy.doc/extract_servicedata_halfmap.htm


                                                                                                                          

Step Action

1 If needed, open the FileNet Deployment Manager and desired deployment tree. 

2 In the Environments node, navigate to and expand the node for the source environment. 

3 Double-click on the source environment node (claimsDEV in the example) to open it.

4 Use the Retrieve Data button for the type Service to start the wizard to retrieve the data.

5 On the first Retrieve Data for  Service Half Map dialog, choose From CE Deploy Dataset 
File .

6 On the next Retrieve Data for Service Half Map dialog, 

• Use the Browse button to select the deploy dataset  containing the exported assets the 
services information will be extracted from. In our example the deploy dataset is 
located in the deployment tree at C:\Demo\FileNet Deployment 
Managerdata\Environments\claimsDEV\Assets\ClaimsSolutionFileNetAssets

• The behavior of Merge or Overwrite is as described before for the Security Principal 
half map. Since this is a new environment both modes yield the same result and a mode 
of Overwrite was chosen.

Click Finish to start the extraction process.

7 Verify the process completed successfully.



                                                                                                                          

Step Action

Click OK to dismiss the   Build service half map dialog.

8 In the navigation pane, double-click on the Service Data node of the source environment to 
open the Service half map.

9 No further edits are needed at this time. This half map will be used in a task later.

Close the Service half map tab.

10 Observe the files holding the object store, principal, and service half maps are now 
populated for the claimsDEV environment in the deployment tree.

Task 4e – Create FileNet Deployment Manager deploy package 

In FileNet Deployment Manager, a deploy package is a compressed file of deployable assets 
that FileNet Deployment Manager can utilize to migrate them into a different environment. 
Using a deploy package is a multi-step process. First use FileNet Deployment Manager to 
construct a deploy package from the assets that were previously exported creating a deploy 



                                                                                                                          

dataset. Then you transfer the deploy package (zip file) to a different system for use by an 
instance of FileNet Deployment Manager that can access the destination environment. Finally, 
FileNet Deployment Manager is utilized to expand the deploy package and subsequently 
execute all the tasks to complete the migration and deployment process. 

This task shows how to create a deploy package for the example deploy dataset 
ClaimsSolutionFileNetAssets.

Step Action

1 If needed, open the FileNet Deployment Manager and desired deployment tree. 

2 Use File > Deploy Package > Create Deploy Package  to launch the wizard.

3 On the Create a Deploy Package dialog, 

◦ Use the Browse button to locate and select the desired deploy dataset to use to 
create the deploy package. In this example, C:\Demo\FileNet Deployment 
Managerdata\Environments\claimsDEV \Assets\ClaimsSolutionFileNetAssets

◦ Verify the Source Environment reflects the desired environment to get the half 
maps from.  (By default it is pre-set to the environment the Create a Deploy 
Package wizard was launched from.)



                                                                                                                          

Step Action

4 ◦ For the Deploy Package location, use the Change button to place the package in a 
location where it can be easily found. In our example we'll put the FileNet 
Deployment Manager deploy package in a well-known location. The same well-
known location was used in Part 1 of this series when the solution package was 
created by exporting the solution with the IBM Case Manager administration 
client.

Click Finish to start the creation of the deploy package.



                                                                                                                          

Step Action

5 Verify the process completed successfully.

Click OK to dismiss the completion dialog.

 

Prepare to import into destination environment 

Unlike the IBM Case Manager assets which are imported into a staging object store, import of 
the other FileNet P8 assets is directly into the destination target environment. Therefore the 
import operation is not performed until the Deploy phase of the migration and deployment 
process. 

However many tasks can be performed in preparation for the deploy. Doing as much work as 
possible before the deploy reduces the time and effort of that phase and will facilitate getting 
the UAT or PROD system back online as soon as possible.

One such set of tasks is the one-time setup of an FileNet Deployment Manager deployment tree 
and environment to support the destination environment.  If a deployment is disconnected or 
different computers will be used to perform the export versus the import, then another 
deployment tree must be created. You would repeat the tasks in the section “Prepare” above to 
create an FileNet Deployment Manager deployment tree and FileNet Deployment Manager 
environment to represent the destination environment. This would be completed as a one-time 
effort before starting the next set of tasks. In this example, an FileNet Deployment Manager 
environment called claimsUAT was created in the destination environment's FileNet 
Deployment Manager deployment tree. The PE connection point for the destination target 
environment where the solution will be deployed is chosen.



                                                                                                                          

The half map for the object stores at the destination was also generated as previously described.

The FileNet Deployment Manager deployment tree can be stored locally on an individual 
solution administrators desktop or placed in a central location where access to it can be 
coordinated.

Task 8a – Extract FileNet Deployment Manager deploy package 

The FileNet Deployment Manager deploy package created previously would have typically 
been bundled with the other solution application artifacts such as the solution package,  and 
security or audit configuration manifest packages. This bundle might be managed using a 
source control system or some formal process to ensure all the pieces being deployed as the next 
version of the solution application will be well understood. The deploy package would have 
been transferred to the destination environment as a part of the overall solution application 
bundle.

The FileNet Deployment Manager instance used for the destination environment will then 
typically be asked to expand the deploy package and subsequently execute all the tasks to 
complete the migration and deployment process. The deploy package extraction can either 
create the required FileNet Deployment Manager source environment in the deployment tree, 
or the expanded deploy package can be placed within a pre-existing source environment in the 



                                                                                                                          

deployment tree. This allows a solution redeployment to leverage the work to create the source 
and destination half maps, and source-destination pair mapping assignments  from previous 
solution application migrations. 

This example shows a first time migration to a destination environment that is disconnected 
from the source. A new FileNet Deployment Manager deployment tree and FileNet 
Deployment Manager environment that connects to the destination FileNet P8 domain were 
created as a part of the preparation of the destination system. 

With a disconnected deployment, the original source environment is presumed to be 
unavailable. FileNet Deployment Manager makes this assumption as well and the connection 
specifications from the source are not carried across in the FileNet Deployment Manager deploy 
package. Assuming the source half maps were completely populated before the deploy package 
was created, additional information from the source will not be needed.

Step Action

1 If needed, open the FileNet Deployment Manager and desired deployment tree. 

2 Use File > Deploy Package > Expand Deploy Package to start the wizard.

3 On the Expand a Deploy Package dialog,

◦ Use the Browse button to navigate to and select the zip file containing the FileNet 
Deployment Manager deploy package.

◦ For Source Environment , select the option to Create New Source Environment 
and assign a name. In this example we used the same name as before, claimsDEV, 
but that is not a requirement. 

◦ For the Half Map Mode, choose Extract from Package from the pull-down. 
◦ Leave the value for Deploy Dataset at its default setting. We'll let the deploy 

package be expanded into its default location in the deployment tree.

Click Finish to start the expansion process.



                                                                                                                          

Step Action

4 Verify the process completed successfully.

Click OK to dismiss the  completion dialog.

5 In the Environments node, navigate to and expand the node for the source environment just 
created by the expand deploy package wizard. 

6 Double-click on the source environment node (claimsDEV in the example) to open it.

7 In the navigation pane, double-click on the Security Principal Data node of the source 
environment to open the Security Principal half map.

8 Note labels assigned when the half maps were created at the source are retained in the 
deploy package and appear here in the destination.



                                                                                                                          

Step Action

9 Repeat step 6 for the object store and service nodes to verify the extraction of those half 
maps from the FileNet Deployment Manager deploy package.

Task 8b – Create security principals half map 

Having distinct half maps allows each environment to be matched in different source-
destination pairs without requiring individual half maps to be rebuilt. For example, remember 
the traditional P8 application migration model:

DEV > UAT > PROD 

In that model, the UAT environment is both source and destination and would participate in at 
least two source-destination pairings:

DEV-UAT

UAT-PROD

Even with two pairings, only one FileNet Deployment Manager environment with its half maps 
needs to be created for UAT. Although the security principal half map from the source 
environment was brought across in the deploy package, a corresponding half map must be 
created for the destination environment.

In the source environment, the deploy dataset was used to filter the LDAP repository and avoid 
a time-consuming download when the LDAP population was large. For the destination 
environment a deploy dataset is not available. However the information gathered in the 
preparation phase with respect to the security principals that will be used in the source and 
destination environments can be leveraged.

FileNet Deployment Manager allows for the manual creation of a file that can be used to filter 
the LDAP repository. This file is called the Label File.  This is a text file containing the short 
name for each user or group to retrieve. The file can also, optionally, include the value for the 
label to assign in the half map. Enter the values (short names first) for each user and group on a 
separate line and use a comma to separate the short name and label. For example in our 
scenario we might use a file like this:



                                                                                                                          

 CEMPadmin, AdminUSR
 P8admins, AdminGRP

For more details, see the “Extract a security principal half map” topic in the FileNet P8 5.2 
Information Center. 

Step Action

1 If needed, open the FileNet Deployment Manager and desired deployment tree. 

2 In the Environments node, navigate to and expand the node representing the destination 
environment. 

3 Double-click on the destination environment node (claimsUAT in the example) to open it.

4 Use the Retrieve Data button for the type Security Principal to start the wizard to retrieve 
the data.

5 On the first Retrieve Data for Security Principal Half Map dialog, choose From Content 
Engine's LDAP Provider .

6 On the next Retrieve Data for Security Principal Half Map dialog, 

◦ Use the Retrieve Realms button to cause FileNet Deployment Manager to 
populate the available LDAP Realms.

◦ Choose the appropriate LDAP realm (the example only has one possibility).

http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.common.deploy.doc/deploy_mgr_howto_security_principal_half_map.htm


                                                                                                                          

Step Action

◦ For the Filter, choose Use a Label File .

◦ In the Filter Settings , browse to the text file previously created to use as the filter 
file.

◦ For the Mode choose Overwrite or Merge .

Click Finish to start the extraction process. 

7 Verify the process completed successfully.

Click OK to dismiss the  Build principal half map dialog.

8 In the navigation pane, double-click on the Security Principal Data node of the source 
environment to open the Security Principal half map.

9 Observe how the labels provided in the filtering file appear in the half map. Note also these 
are the same labels assigned earlier when constructing  source environment security 
principal half map.



                                                                                                                          

Step Action

10 Close the Security Principal half map tab.

Task 8c – Create services half map 

To create the services half map for the destination, a short cut is available. Typically the 
mapping of services is a simple edit of host and port specifications in a set of URLs. The FileNet 
Deployment Manager services mapping mechanism allows for the direct editing of the services 
information to simply and easily correct those values to reflect a new environment.

The services half map brought over from the source environment in the FileNet Deployment 
Manager deploy package will provide the starting point for listing the services specifications 
that might need correction. If the same services are available to both the source and destination 
environments, then no edit is needed.

For more information see “Create a destination service half map” in the FileNet P8 5.2 
Information Center. 

Step Action

1 If needed, open the FileNet Deployment Manager and desired deployment tree. 

2 In the Environments node, navigate to and expand the node for the destination 
environment. 

3 Double-click on the destination environment node (claimsUAT in the example) to open it.

4 Use the Retrieve Data button for the type Service to start the wizard to retrieve the data.

5 On the first Retrieve Data for  Service Half Map dialog, choose From an Environment's 
Service Half Map .

6 On the next Retrieve Data for  Service Half Map dialog, select the source environment 
created by the expansion of the FileNet Deployment Manager deploy dataset, claimsDEV in 
the example.

http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.common.deploy.doc/prep_pe_create_dest_service_map.htm


                                                                                                                          

Step Action

For the mode choose Merge or Overwrite as desired.

Click Finish to create the half map.

7 Verify the successful completion of the operation and click OK to dismiss the dialog. 

8 In the navigation pane, double-click on the Service Data node of the destination 
environment to open the half map for the service data. Note it appears identical to the 
source environment service half map

9 Edit the entry in the Value column to reflect the correct URL for the destination 
environment. Click in the cell of the Value column and directly edit the value.

10 Use File > Save to commit the changes in the half map.

Close the service data half map tab.

11 Observe that the FileNet Deployment Manager deployment tree built for the destination 
system now has half maps for both the source (claimsDEV from the deploy package) and 
destination (claimsUAT built from information obtained from the destination system) 
environments.



                                                                                                                          

Step Action

 

Task 8d – Create source-destination pair with data mappings

The source-destination pair  identifies the source and destination environments to use for a 
specific deployment. The data gathered for the pair includes the desired mappings between the 
environments for corresponding object stores, services, and security principals. The half maps 
for the two environments are used as a starting point. FileNet Deployment Manager then 
generates a first pass at the mappings matching entries using the assigned labels and, if no 
labels match, logical values such as security principal short name. FileNet Deployment Manager 
then provides the user with an opportunity to correct the default mapping and provide the 
appropriate values for unmapped entries.

This task demonstrates how to create a source destination pair and how to use the FileNet 
Deployment Manager user interface to verify the mappings created by FileNet Deployment 
Manager. For more details on how the mappings are represented in the FileNet Deployment 
Manager deployment tree, see “Deployment configuration formats” in the FileNet P8 5.2 
Information Center. 

As you work with the data mapping dialogs, take note of these icons:

http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.common.deploy.doc/deploy_mgr_file_formats.htm


                                                                                                                          

Icon Description

More information is available about the items in the row of the data grid. 
Hover over the icon to see the additional details.

Mapping generated from FileNet Deployment Manager default matching rules 
based on  item attributes.

Mapping is explicit user match using labels or direct assignment on the data 
mapping dialog.

No match exists; item will not be mapped during conversion.

For more information about working with FileNet Deployment Manager data maps, see FileNet 
P8 5.2 Information Center topic “View or update a data map”. 

Step Action

1 If needed, open the FileNet Deployment Manager and desired deployment tree. 

2 Select File > New > Source-Destination Pair 

http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.common.deploy.doc/deploy_mgr_howto_view_data_map.htm


                                                                                                                          

Step Action

3 On the Create a new Source-Destination Pair dialog, fill in a descriptive name, description, 
and select the FileNet Deployment Manager environments that will participate in the roles 
of source and destination.

Click Finish to create the new pairing.

4 Expand the new claimsDEV-claimsUAT node in the navigation pane under the Source-
Destination Pairs node

5 Double-click on the Object Store Map node to open it. 

To create the mapped data, FileNet Deployment Manager examines the half maps 
for the two environments and matches the values using the Object Store names. In 
our example this is not the desired mapping since the import of the other FileNet P8 
assets will be from the target object store for the development environment project 
area (TARGET2OS) to the target object store for the target environment in UAT 
(claimsOS). To correct this inaccurate (but understandable) default choice by FileNet 
Deployment Manager, the mapping for claimsOS must first be undone. 

This type of replacement edit is typical where object store names are the same 
between P8 domains due to naming standards or where the source and destination 
environments are part of the same P8 domain.

6 The example scenario needs to map TARGET2OS to the claimsOS object store in the 



                                                                                                                          

Step Action

destination environment. However claimsOS is already mapped – to itself. Attempting to 
use claimsOS as the destination for a second mapping with TARGET2OS will result in an 
error.

To first remove the mapping assigned to claimsOS,  use the drop-down present in each cell 
for Destination Name. Scroll-up to the first entry which is blank indicating a choice of none. 
Select the blank entry. This makes claimsOS not mapped.

7 To assign claimsOS as the mapped object store for TARGET2OS , use the drop-down 
present in each cell under the Destination Name column. To do this, locate TARGET2OS 
under the Source Name column and use the drop down in the Destination Name column to 
select desired destination object store, claimsOS in the example .

Note how the next screen capture below shows a warning symbol on the row for claimsOS 
and ### in the Destination Name. This calls attention to the situation of a now unassigned 
destination mapping. This situation is noteworthy because if a required entry in the deploy 
dataset does not have a corresponding mapping, the conversion of a deploy dataset will fail. 

Unmapped entries should be carefully examined to ensure they will not cause errors in 
subsequent FileNet Deployment Manager operations. But it is not uncommon to have 
unmapped entries.

 Sort by the second mapping status column in the Map pane to arrange all unmapped 
entries together to find them easily.



                                                                                                                          

Step Action

8 Use File > Save to save the mapping changes

9 Close the Object Store Map tab

10 Double-click on the Security Principal Map node to open it. 

To create the mapped data, FileNet Deployment Manager examines the half maps for the 
two environments and matches the values using the labels or shortnames. In this example 
labels were purposefully assigned by the user when the half maps were originally created 
and FileNet Deployment Manager does not need to make any default assignments.

Examine the mappings to verify the intended pairs of security principals are reflected

 Hover on information icon to see additional details about the entries. 

11 If any modifications were made, use File > Save to save the mapping changes

12 Close the Security Principal Map tab

13 Double-click on the Services Map node to open it. 

To create the mapped data, FileNet Deployment Manager examines the half maps for the 
two environments and matches the values using the names. The values for the destination 



                                                                                                                          

Step Action

environment were assigned when the destination half map was created. The service data 
map for the source-destination pairing cannot be directly modified. If changes are needed, 
the destination half map would be edited and the source-destination service data map 
regenerated to reflect the change.

14 Close the Service Map tab

 

Task 8e – Convert deploy dataset using mapping data

The convert operation uses the export deploy dataset and the data maps to convert the source 
objects with information specific to the destination environment. During the conversion 
process, errors can occur when unmapped entries are present in the deploy dataset being 
converted. An unmapped entry is benign as long as it is not referenced in the exported data.

The mapping performed in the previous task does not appear in the converted 
deploy dataset until the convert operation is performed. If a mapping is modified, the 
convert operation must be run again to apply that modification to the converted deploy 
dataset.

Step Action

1 If needed, open the FileNet Deployment Manager and desired deployment tree. 

2 Expand the Source-Destination Pairs node and double-click on the desired source-
destination pair to open it.  On the overview tab for the source-destination pair, verify the 
settings  of the check boxes under Use when converting assets . 

These check boxes allow the FileNet Deployment Manager user to choose, for a 
given run of the convert operation, whether or not to apply the data mappings that 
were created. 

Notice the default settings for the option Use when converting assets . 

◦ For the object store and service data maps, it is not an option as those 



                                                                                                                          

Step Action

mappings must be applied. 
◦ The option is not set for storage policy and storage area since in this 

example, those data maps do not exist so using or not using the non-existent 
data maps is a moot point.  

◦ Although the option to not apply the security principal mappings does 
exist, typically those mappings are important.  They can only be ignored if 
you are sure that all referenced principals have the same names and SIDs in 
both environments. This might be the case for some FileNet Deployment 
Manager use cases. But since solution application migration is typically 
between different environments, the mappings need to be applied in the 
conversion process and the selection should stay.

Review the summary information for the number of entries in each map and if any are 
unmapped. Generally all security principals and service entries need to be mapped if those 
lists were generated from the exported assets (deploy dataset) as they were in this example. 
The object stores may not all be mapped as typically only a few are involved in a given 
assets migration process.

3 Right-click on the desired source-destination pair to bring up the context menu and choose 
Convert Assets .

4 In the Asset Type Selection dialog, choose Content Engine Deploy Dataset .



                                                                                                                          

Step Action

5 On the Select Source Deploy Dataset dialog, browse to and select the file system folder 
containing the exported data.  By default this is under the source environment's Assets 
folder in the deployment tree. In our example that environment was created for the 
destination system by using information extracted from the deploy package: 

C:\Demo\DESTdata\Environments\claimsDEV\Assets\ClaimsSolutionFileNetAssets

6 On the Select Output Folder for Converted Deploy Dataset dialog,  browse to and select 
the location to place the converted data.  The default location is in the Assets folder under 
the destination environment in the deployment tree since the conversion is relative to 
mappings for a particular destination environment. The converted data will be placed in a 
folder named for the deploy dataset and the suffix .converted added.

Click Finish to begin the deploy dataset conversion process. 

If prompted about the presence of unmapped elements, confirm they are expected and 
choose Yes to continue. If not expected, choose No and return to the edit of the data maps.

7 Verify the process completed successfully. Confirm the number of items processed matches 
with the number of items originally exported.

Click OK to dismiss the completion dialog.



                                                                                                                          

Task 8f – Generate change analysis report 

 Change Impact Analysis is an information-only operation that reports  on but does not modify 
the destination environment. The report includes warnings and errors for potential import 
issues. It also includes sizing and other data reflecting the change impact analysis.

Even if a converted dataset was used successfully in the past, the possibility exists for it to no 
longer reflect the ever-changing state of the destination environment. Because Change Impact 
Analysis connects to the destination environment to analyze the converted deploy dataset, it 
will catch problems in the dataset resulting from a modified destination environment. 

The report will also point out required assets  that are not present in the destination system and 
are missing from the deploy dataset the import operation is dependent upon. The missing 
assets can:

◦ Be part of a new export manifest and generated deploy dataset.
◦ Require modification and reprocessing of the current export manifest to include the 

missing assets in the same deploy dataset.
◦ Dictate the installation or configuration of components required prior to importing the 

FileNet P8 assets.
◦ Show the need to deploy the solution before importing the other FileNet P8 assets.

 Prior to every import operation, the change impact analysis operation should be run on the 
converted deploy dataset and the analyze report carefully reviewed.

For more details about the change impact analysis operation including descriptions of the 
sections and information in the generated report, see the “About change impact analysis” topic 
in the FileNet P8 Information Center.

Step Action

1 If needed, open the FileNet Deployment Manager and desired deployment tree. 

2 Expand the Source-Destination Pairs node and double-click on the desired source-
destination pair to open it. 

3 Right-click on the desired source-destination pair to bring up the context menu and choose 
Analyze .

4 In the Analyze Change Impact , Select source for Change Impact Analysis dialog, choose 
Content Engine Deploy Dataset .

Click Next . 

5 On the Analyze Change Impact on Destination Environment dialog, use the Browse button 
to locate and select the deploy dataset just converted. The data is in a folder with the 

http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.common.deploy.doc/prep_data_ce_analyze_concepts.htm


                                                                                                                          

Step Action

suffix .converted  It will be in the Assets folder under the destination environment since the 
conversion was relative to mappings for a particular destination environment.

6 On the Select Import Analysis Options dialog, the typical choice for  the other FileNet P8 
assets  migrated with a solution application is Always update the object if it exists at the 
destination.

This choice agrees with the migration model described in Part 1 of this series. The 
IBM Case Manager solution migration model treats the development environment 
as the “single source” for the core solution application.. Thus the solution 
application in its entirety, including the other FileNet P8 assets developed in the 
project area, should come from the source environment. Later when import is run, 
this same philosophy is applied.

Click Next .

7 On the Change Impact Report Options dialog, 

◦ Choose a location for the report to be stored. This report is a good reference if the 
business requirements include keeping a log/audit of change operations or if the 
information could be useful for later tracking if issues arise. Designation of a well-
known location to archive these reports can assist with both those uses.

◦ To maximize the available information, and since the deploy datasets used with 
application migrations are typically small, choosing the option to Include details 



                                                                                                                          

Step Action

for all objects in report is recommended.

◦ Optionally indicate the report should be presented for immediate examination by 
choosing View report after processing .

Click Finish to begin the  change analysis process. 

8 Verify the process completed successfully. Confirm the number of items processed matches 
with the number of items converted.

Click OK to dismiss the  completion dialog and open the report (if that option was chosen).



                                                                                                                          

Phase 3 
Deploy  

Deployment order of operation 

Recall from the first Solution Deployment Guide article, before any system modification, it is 
prudent to back-up the portions of the system impacted by the changes. For the best possible 
backup, activity on the system should be temporarily suspended. This allows a consistent 
snapshot of all related data to be captured. And following the backup, access to the system 
should be minimized to avoid further changes that would make the system inconsistent with 
the backup. For details on backups, see “Backing up your system” in the IBM Case Manager 
Information Center.

Also before beginning the solution application deployment, a clear picture of the assets and 
their dependencies should be created. This picture can be included in the solution application 
documentation created in the Prepare phase described in Part 1 of this series.  The task below 
“Import FileNet Content Manager assets” could be needed multiple times both before and after 
the solution is deployed. 

The tasks in this section augment the information presented about the Deploy phase in Part 1 of 
this guide. The tasks are not intended to imply a particular order relative to the deployment of 
the solution itself. However it should be clear from Part 1 of this guide, the solution application 
deployment is not complete until at least the solution is deployed and an appropriate security 
configuration applied.

Assets that might need to be imported before the solution can be deployed include:

◦ Content Platform Engine metadata (property templates, document classes, or choice 
lists) brought into the solution design to be reused.

◦  Content Platform Engine Workflow System assets defined outside of IBM Case 
Manager but incorporated into the solution, such as a workflow system configuration 
or component queue.

Examples of assets that could be imported after the solution is deployed might include:

◦ A stored search that references case properties and is used with a Content List widget.
◦ Translated display names and descriptive text for IBM Case Manager deployed class 

definitions, property templates, or choice lists used to localize a solution. (For more 

http://logos.svl.ibm.com:8094/help/topic/com.ibm.casemgmt.design.doc/acmad003.htm


                                                                                                                          

information about this process, see “Migrating the translated user interface elements of  
your case management application” in the IBM Case Manager 5.2 Information Center.)

This is an example of a dependency between other FileNet P8 assets:

◦ A component queue was configured to utilize a code module stored in the object store 
associated with the workflow system. The code module must be imported before the 
workflow system configuration with the component queue definition can be imported. 
If the code module is not present, the component queue import fails with an error:

Task 8g – Import FileNet Content Manager assets 

FileNet Deployment Manager import options are used to ensure a set of exported assets is 
consistent when imported: 

• Import Object ID  
Specifies a given object's ID is retained. In the case of a document object, the object ID 
represents a specific version of a document. This ensures that for an asset stored as a 
document, like a form template or workflow attachment, the association to a specific 
document object version is retained. This retention of object ID also important to other 
FileNet P8 assets where object references occur. The option must always be selected 
when migrating a solution application.

• Always Update vs. Update if newer
Because it is important for a solution application deployment to fully replicate the 
design from the source development environment, use of the Always Update option is 

http://pic.dhe.ibm.com/infocenter/casemgmt/v5r2m0/topic/com.ibm.casemgmt.design.doc/acmdc045.htm
http://pic.dhe.ibm.com/infocenter/casemgmt/v5r2m0/topic/com.ibm.casemgmt.design.doc/acmdc045.htm


                                                                                                                          

typical. However, if your business needs require that assets modified directly in the 
target environment take precedence over older changes from the IBM Case Manager 
development environment, you can select the Update if newer option. The 
DateLastModified property on the objects in the deploy dataset are compared to the 
same objects in the target environment to determine which objects are newer.

• Use Original Create/Update Timestamps and Users

Selecting this option imports the values of certain Content Platform Engine system 
properties which allows verification that the destination system has the version 
corresponding to that on the source system.  For example, to ensure the create and 
modify times on the destination match those on the source system, select this option. 
Always select this option if the Update if newer option will be used on future updates of 
the imported assets.

To modify system properties, the FileNet P8 domain user that FileNet 
Deployment Manager utilizes to connect to the P8 Domain must have the Modify 
certain system properties privilege on the destination object store or the import 
operation returns errors.

 A document object represents a specific version of a document whose content is stored as 
content elements. A document object's properties can be modified, but the content elements 
cannot. If the import option “Import Object ID” is specified, and an imported document object 
already exists in the destination object store with the same ID, the content of the imported 
document will be unchanged even if the convert operation altered its contents in the converted 
deploy dataset. If this occurs, take one of the following actions:

• From the destination object store, delete the particular version of the document being 
imported. This causes the document version to be created, not modified, by the reimport. 
Note that when you import a document object, it is assigned the next appropriate major 
and minor version number. The major and minor version numbers from the source system 
are not retained. Thus if a version is removed from the middle of a version series, when 
reimported, it will become the newest, and therefore the current, version. 

• If  the particular document version cannot be deleted prior to import, for example the 
history of versions in the destination system is important to maintain, manually modify the 
content using appropriate tools in the destination system after the import completes.



If you are importing metadata into a clustered or load-balanced set of servers, you need to 
restrict the FileNet Deployment Manager's server requests to one server. This is necessary to 
ensure the metadata cache in the server utilized by the import operation is synchronized. The 
requests can be restricted by performing the import operation when only a single Content 



                                                                                                                          

Platform Engine server is available. This is typically during a maintenance window when all 
but one of the application server instances hosting the Content Platform Engine server can be 
stopped. Solution application deployments should occur during such a maintenance window to 
minimize system  activity during the Deploy phase.

Step Action

1 If needed, open the FileNet Deployment Manager and desired deployment tree. 

2 Expand the Source-Destination Pairs node and double-click on the desired source-
destination pair to open it. 

3 Right-click on the desired source-destination pair to bring up the context menu and choose 
Import .

4 On the Options dialog make the following selections for the most straight-forward import 
that will be in keeping with the solution application migration model advocated by this 
deployment guide.  For details about these options in the context of an IBM Case Manager 
solution, see the IBM Case Manager 5.2 Information Center topic “Importing assets by using 
FileNet Deployment Manager”.

Select Storage Policy for Imported Objects typically utilizes the default which allows the 
configuration in the target object store to be applied: Use default storage policies …. 

Standard Options:

All these options may be selected or deselected except for Import Object ID which must be 
selected. Following are suggestions only.

• Import Security Permissions: Optionally deselect
Causes default security configured in the target object store to be inherited by the 
imported objects.

• Import Owner:  Optionally deselect 
Results in the user account utilized by FileNet Deployment Manager to connect to 
the Content Platform Engine to become the owner of newly created objects.

• Import Object ID: Select 
• Use original create/update timestamps and users: Optionally select  

If you select this option you must ensure the user account FileNet Deployment 
Manager used to connect to the FileNet P8 domain also has the Modify certain 
system properties privilege on the target object store 

• Import Retention: Optionally deselect 
Assets used in application definitions are not typically managed using content 
retention policies.

• Transfer workflows after import : Optionally select  
If an external workflow definition was included in the deploy dataset, this option 
might be selected.

Update Options

• Always Update: Select 

http://pic.dhe.ibm.com/infocenter/casemgmt/v5r2m0/topic/com.ibm.casemgmt.design.doc/acmdc079.htm
http://pic.dhe.ibm.com/infocenter/casemgmt/v5r2m0/topic/com.ibm.casemgmt.design.doc/acmdc079.htm


                                                                                                                          

Step Action

Create Options

• Create if new : Select 

Click Finish skipping the advanced option to utilize a pre-import script starting the import 
process. 

5 Verify the process completed successfully. Confirm the number of items processed matches 
with the number of items converted.

Click OK to dismiss the  completion dialog.

6 If all deploy packages associated with this solution application deployment that will be 
imported at this time have been processed, exit FileNet Deployment Manager. 

7 Use ACCE to open the target object store to confirm the assets were imported as expected. 
The solution's deployment instructions should include a description of the assets along with 
their expected location in the destination system. In this example the FileNet P8 assets 
include:

The folder CodeModules_WF with its contained code module.

The folder forms with is contained form template.



                                                                                                                          

Task 8h – Import FileNet workflow system assets 

Import the required Content Platform Engine Workflow System assets into the target 
environment where the solution application will be deployed. Required Workflow System 
assets are assets that are created with the Process Configuration Console or Process Designer, 
not assets that are created in Case Manager Builder.

In the example solution, a component queue is used to make a call into the Content Platform 
Engine using a custom application providing functionality beyond that provided by the 
CE_Operations queue. That component queue definition was exported in the above task “Task - 
Export FileNet Workflow System configuration”.

 

Step Action

1 Log into the IBM Administration Console for Content Platform Engine (ACCE) using the 
URL

http://<CPEserver_host:CPEserver_port>/acce

2 Open the object store used as the target object store for the IBM Case Manager target 
environment the solution application will be deployed to.

3 The Process Configuration Console can be found for a given object store on the 
Administrative node, Workflow System > Actions > Configure Workflow Settings

4 After the Process Configuration Console java applet is launched, from the Workflow 
Systems listed, select the connection point for the IBM Case Manager target environment 
where the solution application will be deployed. 

With the Action menu, use the Connect operation and connect to the desired workflow 
system. 



                                                                                                                          

Step Action

5 With the Action menu, use the Import from XML file operation to launch the import 
wizard.

6 On the Import Configuration dialog, 

Browse to the XML file previously created when the configuration queue definition was 
exported from the source environment (project area).

Choose Import Type of Merge 

For a solution redeployment, or if multiple solutions share the same target 
environment, the merge option preserves any existing properties in the 
destination target environment and adds new properties from the development 
environment project area.

Click Import to start the import process.



                                                                                                                          

Step Action

7 Click Yes to dismiss the dialog warning that these changes are immediately deployed to 
the run-time system.

8 Wait for successful completion.

Use the Details button to see a summary of the modifications made to the workflow 
system.

Use the Close button to dismiss the dialog when complete.

9 Use File > Exit to close the Process Configuration Console .

Deploy solution 

As described in part 1 of this guide, the additional tasks to deploy the solution would be 
completed at this time before moving onto system configuration. Also, if needed, the tasks 
described in this article to import additional FileNet Content Manager assets might be used 
again after the solution is deployed if those assets depend on the solution deployment.

For detailed steps on how to deploy a solution, please see the developerWorks article “IBM 
Case Manager 5.2 Solution Deployment Guide Part 1: Basic Solution Deployment and 
Migration”. 

 

https://www.ibm.com/developerworks/community/groups/service/html/communityview?communityUuid=e8206aad-10e2-4c49-b00c-fee572815374#fullpageWidgetId=Wf2c4e43b120c_4ac7_80ae_2695b8e6d46d&file=3cdde542-efe9-49c8-bdc0-32de7683cad5
https://www.ibm.com/developerworks/community/groups/service/html/communityview?communityUuid=e8206aad-10e2-4c49-b00c-fee572815374#fullpageWidgetId=Wf2c4e43b120c_4ac7_80ae_2695b8e6d46d&file=3cdde542-efe9-49c8-bdc0-32de7683cad5
https://www.ibm.com/developerworks/community/groups/service/html/communityview?communityUuid=e8206aad-10e2-4c49-b00c-fee572815374#fullpageWidgetId=Wf2c4e43b120c_4ac7_80ae_2695b8e6d46d&file=3cdde542-efe9-49c8-bdc0-32de7683cad5


                                                                                                                          

Phase 4 
Configure 

General system configuration

After a solution is migrated and deployed, depending on the features of the solution, additional 
system configuration steps might be required. When a solution is deployed to a system for the 
first time, steps beyond the migrate and deploy may be required to configure it into the new 
environment.  When a solution is redeployed, system configuration information may be 
overwritten during the redeployment process and may need re-specification. However most 
configuration steps should not need repeating

For objects managed in the FileNet Content Platform Engine, a majority of the configuration is 
migrated when the object is deployed using FileNet Deployment Manager. However some 
elements that might need additional configuration after deployment include:

• Component queue JAAS credentials (export/import tools typically do not manage 
passwords)

• Component Manager configuration and start (legacy component queues)

• JMS JNDI specifications for a JMS queue

• Supporting libraries not included in code modules migrated with the solution 
application but referenced by action handlers or component queues used with the 
solution

In the example, the component queue configuration must be modified to have the proper JAAS 
credentials.

Task 9 – Configure Component Queue

For a component queue, the Adapter and Operations tabs contain information brought to the 
destination system with the export/import of the queue definition using the Process 



                                                                                                                          

Configuration Console. Some properties may need modification to reflect the destination 
system. For example, typically the JAAS credentials must be updated to reflect the correct user 
account for processing the component queue on the target environment.

For more information about the Java adaptor and its properties, see “Creating a component 
queue” in the FileNet P8 Information Center.

 

Step Action

1 Log into the IBM Administration Console for Content Platform Engine (ACCE) using the 
URL

http://<CPEserver_host:CPEserver_port>/acce

2 Open the object store used as the target object store for the target environment the 
solution application will be migrated to.

3 The Process Configuration Console can be found for a given object store on the 
Administrative node, Workflow System > Actions > Configure Workflow Settings

4 After the Process Configuration Console java applet is launched, from the Workflow 
Systems listed, select the connection point for the project area where the solution 
application resides. 

With the Action menu, use the Connect operation and connect to the desired workflow 
system. 

5 Expand the Component Queues node and double-click on the CEOpsExtended 
component queue to access its properties.

http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.pe.configui.doc/bpfc084.htm
http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/topic/com.ibm.p8.pe.configui.doc/bpfc084.htm


                                                                                                                          

Step Action

6 If modifications are made on the Component Properties dialog, use the OK button to 
save them temporarily.

7 Use the Commit operation on the main Process Configuration Console dialog to apply 
these changes to the isolated region for the target environment.

8 On the Commit changes in Workflow System dialog, review the information about the 
changes that will be applied. 
Click Continue to start the commit changes process. 
Wait for successful completion.
Use the Close button to dismiss the dialog when complete.

9 Use File > Exit to close the Process Configuration Console .
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Appendices 
Appendices   

Case Manager Tools to FileNet Deployment Manager Terms

FileNet Deployment Manager Term IBM Case Manager Term 
Source environment Project area (DEV), Target Environment (UAT/PROD)

Destination environment Target environment

Source-Destination pair Project area >> test/production target environment.

Export Migrate (export tasks)

Deploy (import) Deploy 

Application Solution application

Security principals Users and groups

Service data Any environment specific data embedded in an asset that can 
be mapped and converted to a target environment value 
during deploy/import 

ID or GUID (unique identifier for a Content 
Platform Engine object)

Object identifier, ObjectID, or GUID

Document Conventions  

The following documentation conventions are used to assist in performing a task:

Convention Explanation

Bold Words that appear in boldface represent menu options, buttons, icons, or any object you 
click to cause the software to perform a task.  This typeface also represents anything that 
you must type or enter. 

italics In addition to book or topic titles, italics are used to emphasize certain words, especially 
new terms when they are first introduced.
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Note Signifies information that emphasizes or supplements important points of the main text.

   
Important Signifies information essential to the completion of a task.  You can disregard information 

in a note and still complete a task, but you should not disregard an important note.

  
Caution This alerts you to follow a recommended procedure carefully.  Failure to do so may result 

in installation or configuration problems or other preventable conditions.

  
Tip This  helps you understand the benefits and capabilities of a feature or function.  It may 

also provide an overview of an alternate method. A tip is not essential to the basic 
understanding of the text.

 This symbol indicates the end of a note, caution, or tip.
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